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K* Risk 

1 
Lack of game development 
knowledge and experience 
for team 

2 User-interface shortfalls 

3 Poor initial design 

4 
Lack of time to complete all 
necessary requirements 

5 Feature creep 
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HELP

- Modify the GREEN cells and the WBS, Tasks, and Task Lead columns. The rest of the columns are formulas.
- The number of weeks shown in the gantt chart is limited by the maximum number of columns available in Excel.
- The Start Date that you choose determines the first week in the gantt chart, starting on a Monday.
- Use the slider to adjust the range of dates shown in the gantt chart.
- Only 48 weeks can be shown/printed at one time, because each week uses up 5 columns.

Q: The Working Days column shows "###". How do I fix that?
You need to install the Analysis ToolPak add-in that comes with Excel. Go to Tools > Add-ins, and select Analysis ToolPak.

Q: How do I make Task 2 start the day after the end of Task 1?
Use the following formula for the start date of Task 2:
=EndDate+1
where EndDate is the reference to the cell containing the end date of task 1

Q: How do I add/insert tasks and subtasks?
Copy the entire ROW (or a group of rows) for the type of task(s) you want to add and then right-click on the row where you want to insert the new tasks, then select Insert Copied Cells
Important Note: When inserting a new subtask after the last subtask or before the first subtask, you will need to update the formulas for calculating the Level 1 %Complete and Duration 
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1 Introduction 

This  document will  be  used  to  define  the  blueprint  design  for  Dude*X.  Each  section will  outline  the 
design  of  a  specific  component  of  the  game.  The  intention  is  to  combine  all  sections  to  create  an 
application that can be tested and will lead up to the final release candidate version of the game. 

1.1 Intended Audience 

This document is intended to be viewed by the lead programmer, and, as needed, the game developers 
themselves.  The  technical  language has been kept  so as  to not  lose  the details  needed  to  create  the 
envisioned game.  

1.2 Game Overview 

Dude*X is a 3D third person strategy game for PC, OS X and Linux in which the gamer is challenged to 
cooperate with “ghosts” of themselves to reach the highest floor of the game. The game consists of 10 
rounds with each  round of  roughly 60  seconds  creating a new “ghost”  that  repeats  its  action  for  the 
remaining  rounds.    The  gamer  is  required  to  use  these  “ghosts”  to  solve  problems  and make  it  up  a 
series of stairs in order to reach the highest floor and win the game.   

For more information please see (MacWilliam 2008). 

 

2 Game Mechanics 

This section outlines the technical specifications of the systems and code needed to run Dude10. 

2.1 Platform 

Dude*X will be a downloadable desktop application that works on the following operating systems: 

 Windows 2003/XP/Vista 

 Mac OS X 10.4.10+ 

 Linux 
The  minimum  requirements  to  play  Dude*X  at  the  game  speed  intended  the  following  minimum 
requirements are required: 

 Processor exceeding 1.0 GHz 

 512 MB RAM 

 Video card with onboard memory (not required, but will result in better performance) 

 Stereo Speakers (not required, but increases game experience) 
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2.2 External Code 

This section will describe the various external code and libraries that will be used to create Dude*X. 

2.2.1 SDL 
Graphics 
Simple DirectMedia Layer  is a  cross‐platform multimedia  library designed to provide  low  level 
access to audio, keyboard, mouse, joystick, 3D hardware via OpenGL, and 2D video frame buffer  
(Simple DirectMedial Layer). SDL will be used in Dude*X to handle the user interaction as well as 
the video management needed to give Dude*X its look and feel. 
Audio 
To create the unique sound of Dude*X SDL_mixer will be used.  SDL_mixer  is a special project 
under  the  SDL  group.  It  is  similar  to  the  standard  audio  that  comes  with  SDL,  except  it  can 
handle a variety of audio formats, and can play multiple channels of sound.  This means that the 
game developers can easily program Dude*X to have background music playing while multiple 
sound  effects  are  be  playing  all  at  once,  with  no  effect  on  the  game  play  .  SDL_mixer  also 
provides cross fading and grouping of sounds, enabling the game developers to greatly enhance 
game play through sound if time permits. 

2.2.2 Lua 
Lua  is  a  powerful,  fast,  light‐weight,  embeddable  scripting  language.  It  combines  simple  procedural 
syntax with powerful data description constructs based on associative arrays and extensible semantics. 
Lua  is dynamically  typed,  runs by  interpreting bytecode  for  a  register‐based virtual machine,  and has 
automatic memory management with incremental garbage collection; making it ideal for configuration, 
scripting, and rapid prototyping (Pontifical Catholic University of Rio de Janeiro 2008).   

Lua will be used by the game developers to easily modify components of the game without recompiling.  
It will be used extensively to handle scripts of objects and sounds that can be used to dynamically create 
new levels. Lua can also be used by future gamers to customize components of Dude*X to their liking. 

2.2.3 3D Studio Max 
3D  Studio  Max  (3Ds)  is  a  full‐featured  3D  modeling,  animation,  rendering,  and  effects  solution  to 
produce video and game content (Autodesk n.d.). It will be used in Dude*X to create some of the more 
complicated objects, as well as the animation (see section 7).   3Ds will allow the developers to create 
models for the Dude, as well as the buttons and switches needed for the game.  These models will also 
utilize 3Ds’ ability to easily develop complex keyframe animation  in order to bring more  lifelike to the 
game. 
 
Nevertheless,  in  order  to  import  3Ds  files  into  Dude*X  a  3Ds  loader  will  need  to  be  created  by  the 
developers to read in the 3Ds files and extract the model and animation information.  This information 
will then be used by the game developers and coded into the game through Lua and SDL. 
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2.3 Control Loop 

The main function for Dude*X will set up the correct graphics, video and audio settings for displaying the 
game.  This includes setting the screen size and enabling the various OpenGL properties that are require 
for the game (such as the shading mode and culling settings).  Some of these settings will be based on 
the gamers’ preferences that are saved each time the game is played.   

Once the correct graphics, video and sound have been set the peripherals are initialized. This includes 
setting up the managers for the keyboard, mouse, screen and any other events needed during the game.  
Finally the Lua scripting engine will be initialized.  This sets up the basic Lua functionality that is required 
by  the majority of  the game  components.   No,  game  specific  content  is  loaded at  this  time.    Specific 
levels  level  information (walls, models, sounds, etc.) are  loaded when they are needed.   Once the Lua 
engine is complete the main menu is displayed and the main event loop is entered. 

The main event loop will handle the timer that will synchronize all the updates.  It will handle calling the 
correct  update  routines  utilized  by  SDL  and  Dude*X.    Because  each  major  component  of  the  game 
(screen,  keyboard, mouse, Dude,  coin,  elevator,  sound,  event manager,  etc) will  have  their  very  own 
update methods,  the main event  loop will  handle  calling  them at  the appropriate  time.   Once all  the 
update methods have been called the updated screen will be displayed for  the gamer.   The goal  is to 
achieve a frame rate of greater than 60 frames per second. 

For a detailed view of the flow of the main game control loop please see Figure 2.1 below.  A detailed 
breakdown of the event loop within the main game loop can be found in Figure 2.2. 
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Figure 2.1 Game Loop Flowchart 
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Figure 2.2 Event Loop Flowchart 
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3 Game Object Data  

Because Dude*X will require the managing of a plethora of objects,  instead of discussing each object in detail the following class diagram has 
been given as an outline for the design and interaction of all objects within the game.  Discussion of major classes will be discussed after the 
figure. 

 

Figure 3.1 Main Class Diagram 
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3.1.1 Screen 
Screen  is  an abstract  class  that  implements  the  IDrawable  and  IUpdateable  interfaces.    It  defines key 
virtual methods  draw()  and update()  that must  be  defined by  all  classes  implementing  Screen.  These 
classes include: 

 SelectionScreen 

 MainMenuScreen 

 HUDScreen 

 ConsoleScreen 

 EndOfGameScreen 

 GameScreen  

 OptionsScreen 

 FadeScreen 
Each of  these screens will be accessed and drawn to the screen as needed through a ScreenManager 
class,  which  will  contain  a  list  of  all  screens,  as  well  as  a  list  of  buffered  screens.    For  a  detailed 
breakdown of what each screen is for please see section 6. 
 

3.1.2 Event 
Figure 3.2 outlines the implementation of the abstract Event class that is used to define events that are 
handled in the game.  The virtual methods that need to be implemented in each class that inherits Event 
are play(), getType(), getModel() and getTarget(). 
 

 

Figure 3.2 Game Event Class Diagram 

3.1.3 Controller 
Figure 3.3 outlines the implementation of the abstract IController class that is used to define the various 
controllers  in  the  game.    All  controller  classes  implement  the  abstract  IController  class.  The  virtual 
methods that need to be implemented in each class that inherits  IController  are attachTo(), update(), 
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isEnabled(),and setEnabled().   All controllers are managed by the ControllerManager class  that has an 
array of IController objects.  The ControllerManager class allows an easy way to add, remove and get the 
various controllers active in the game. 

 

Figure 3.3 Controller Class Diagram 

3.1.4 Lua 
Figure 3.4 outlines the implementation of the abstract ILuaFunctExporter class that is used to define the 
interface  for all  classes wanting  to  interact with  the Lua scripting engine.   The  Lua scripting engine  is 
handled by the LuaC class and Lua functions can be called in game through the game console (Console 
class) or through Lua scripts.  The ILuaFunctExporter defines two static functions: 

 registerFunct(lua_State *pLuaState)‐exports function to a Lua State 

 registerFunct(LuaC* luaObj) – exports function to a LuaC object 
 

Every class that inherits ILuaFunctExporter must create an array of LuaFunctions (defined in LuaC) that 
will  be  called  from  Lua  scripts  or  through  the  console.  These  LuaFunctions  are  pointers  to  functions 
defined  in  the  inheriting class  (i.e.  LuaObjMgr).   Once  the array of LuaFunctions  is  initialized with  the 
correct function pointers the class must also implement both registerFunct functions, which will export 
the functions into the correct Lua states and LuaC objects.  Once the LuaFunctions have been registered 
correctly they can be called from within the Console or through a Lua script. 
 

 
Figure 3.4 Lua Class Diagram 
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Lua will be used for testing and making large changes to the game without the need to recompile.   As 
such, some critical components that will need to have Lua implementations are: 

 Objects (walls, floors, coins, etc) 

 Physics (bounding boxes) 

 Preferences (resolution, fullscreen) 

 Sound (sound effects, background music) 
 
Each of  these  components will  be  initialized  and  controlled  through  a  component manager  class  (i.e. 
SoundManager) that will have functions to access and use a list of loaded components (i.e. play or pause 
music). Together these Lua components will be used to create Lua scripts of each level defined in section 
6.1 of the Functional Specification document (MacWilliam 2008). 

3.1.5 3DS Models 
Figure 3.5 outlines the implementation of the 3DS models in the game.  Toolkit3DSModel inherits from 
the  abstract Model  class.    Toolkit3DSModel  implements  some  critical  functions  that  are  needed  for 
animating any object. These functions include: 

 draw(void) –transforms and draws the 3Ds mesh 

 update() – updates all meshes 

 StartAnimation(int animationNumber) – starts the animation 

 StopAnimation(int animationNumber) – stops the animation 

 ResetAnimation(int animationNumber) – resets the animation 

 void setPlaybackSpeed(float value) – sets hows fast or slow the animation runs 

 setLooping(bool value) – sets whether or not the animation should loop 
 

 
Figure 3.5 Toolkit3DS Class Diagram 



Dude*X    Version: <1.0> 

Technical Specification    Date:  4/14/2008 

 

40 

With the exception of loading the Dude model (which creates a Toolkit3DSModel of the Dude within the 
Dude class) the only other 3DS models implemented in the game are the up elevator (red teacup), down 
elevator (blue teacup) and the buttons that the Dude will stand on.  These each inherit and implement 
functions from Toolkit3DSToolkit so they can work specific to their model (i.e. the up elevator runs an 
animation that opens and closes the elevator door), see Figure 3.1. 

4 Game Physics 

As part of the Dude*X game engine, the physics engine will provide support for modeling physical 
objects in the game world.  Essentially, it will be responsible for controlling the movement of objects 
and their interaction, i.e. collision detection and response. 

4.1 Physical Objects 

Three kinds of physical objects will be possible in the engine: 

 Dynamic objects –objects that move between frames and have associated: 
o Position 
o Rotation 
o Velocity 
o Mass 
o Angular velocity 
o Friction coefficient of the bottom 
o Elasticity 
o Any forces that are applied to it 
o Bounding volume 

 Static objects –objects that do not move between frames and thus these objects consist only of 
a bounding volume. 

 Space bound –the bounding volume of the game world.  Although it is similar to a static object, 
it will be treated slightly different. 

4.2 Bounding Volumes 
Bounding volumes are closed shapes that contain the physical objects of interest and are geometrically 
simpler than the objects to improve the efficiency of geometric operations.  Currently, the physics 
engine will support only a single bounding volume per object; in the future it could be expanded to 
follow the models and have possible bounding volumes at each tree node.  The engine will support 
three kinds of bounding volumes: 

 Sphere 

 Cuboid (a.k.a. Box) 

 Cylinder 
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For each volume there will be an option of whether collisions should be monitored inside the volume or 
outside.  This is in part a performance optimization that reduces the number of bounding tests 
necessary.  The “inside” variant could be used for the box volume shape to keep elements inside the 
box, which is useful for the space bound.  Usually, the “outside” variant will be used since not many 
objects will be encompassed within other objects in Dude*X. 
The cuboid volume shape is the most complex shape because it tests against six finite planes.  Since 
collision detection and response for non‐axis aligned finite planes is complex and not necessary for our 
game, the engine will only support axis‐aligned bounding boxes.  However, for the “inside” case, infinite 
planes can be used, and thus support non‐axis aligned boxes for that variant.  This means that the space 
bound does not have to be axis‐aligned. 

Cylinders are infinite in length.  Although collision detection for finite cylinders is not difficult, calculating 
the response would be more involved and is not necessary for the game.  Sphere bounding volumes are 
the simplest and specified by their radius.  A radius of zero would create a point that could be used for 
some collision detection scenarios. 

4.3 Collision Detection and Response 

Collision detection will work by finding the distance between bounding volumes at the next frame.  If a 
collision occurs at the next frame, then the collision response is calculated and the physical object is 
diverted from the collision.  This process occurs only to dynamic objects, as static objects do not move 
between frames.  For each dynamic object, the following will occur for each frame: 

1. Any current forces and acceleration, including gravity are applied. 
2. Velocity from acceleration is updated 
3. Any constant velocity setting from controllers is applied 
4. Test against collisions between other dynamic objects 
5. Test against collisions between static objects 
6. Test against collisions between the object and the space bound 
7. Apply any collision response if there was a collision 
8. Actually move the object by translating it by its velocity 
9. Update and apply friction 

Note that all dynamic objects are tested against all other objects, meaning a complexity of O(n2) is used 
for collision detection, where n is the number of dynamic objects.  This solution will be acceptable since 
there will not be many dynamic objects, and collision detection functions should actually take a 
negligible amount of execution time compared to the rest of the game. 

Since collisions will involve different combinations of static and dynamic objects as well as different 
shapes, only collisions that are needed will be implemented, namely the following is a list of collisions 
will be supported by the physics engine: 

 Sphere vs. static cuboid 

 Sphere vs. static infinite cylinder 

 Sphere vs. static sphere 
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 Sphere vs. dynamic sphere 

 Infinite cylinder vs. static cuboid 

 Infinite cylinder vs. static sphere 

 Infinite cylinder vs. dynamic sphere 
  Details of the math for each collision will not be discussed here.  Collision detection for each 
combination of shapes is a bit different, but collision response will almost always uses the same formula: 

INNIR


 )(2  

Where R is the response vector, I is the incident vector, and N is the vector normal to the surface of the 
collision.  In each case, the methods to determine the normal will be slightly different and sometimes 
approximations are used.  The incident vector will usually be the velocity. 

.

5 Artificial Intelligence 

As mentioned in the Game Concept document (MacWilliam 2008) “Dude*X does not have any AI”.  The 
gamer must use all the Dudes they have and their own intelligence to complete the game.  This section 
discusses how the “artificial intelligence” of the “ghosts” will be developed to accurately re‐enact, step 
by step, the previous dudes’ actions.  

In order to record what happened in a previous round, there are two approaches that can be taken.  The 
events of interest may be recorded, or the gamer input could be recorded.  With either method, the 
recorded entities would be played back for each round.  Event‐based recording (see section 3.1.2) 
should be used because it is more efficient and would rule out any accuracy issues that might be faced if 
going with input‐based recording instead.  This type of recording is different than a “timedemo” because 
interaction still occurs with the recorded state of the game. 

There are two kinds of events that will be recorded: continuously sampled events that are “polled” and 
action‐driven events that are “pushed”.  These will be called MovementEvents and GameEvents, 
respectively.  Other classes or subclasses of these events may be created to specify alternate event 
conditions.  Both will be subclasses of an abstract Event class that contains the time the event occurred, 
and an interface for how it should be replayed.  MovementEvents will be recorded at a specified 
sampling frequency of around 60 Hz for smoothness, and will contain the position and rotation of the 
recorded character.  GameEvents contain information on the type of event, such as a coin pickup or 
button press, and the associated game model with that event.  All events will be stored in a linked list 
that is traversed as the events are played back, and any new events will be inserted as they occur. 
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6 Gamer Interface 

This section outlines the design of the gamer interface necessary to correctly play Dude*X.  The Game 
Shell section will explore the design of all screens other than the Main Play Screen, which will itself be 
outlined in section 6.2.  The intention is that this section will provide enough detail for the lead 
programmer and game developers to understand and implement Dude*X’s gamer interface. 

6.1 Game Shell 

As mentioned in section 3.1.1 there are a variety of screens that will be handled by the ScreenManager 
class.  Each screen implementation is discussed in their own section below. 

6.1.1 MainMenuScreen 
The MainMenuScreen class will implement the Main Menu Screen discussed in section 2.2.1 of the 
Functional Specification  (MacWilliam 2008).  It will be the first screen loaded and displayed when the 
gamer starts up Dude*X. The screen should be simple and should display the name of the game and any 
instructions needed to take the gamer to the next screen: the SelectionScreen.  When the next screen is 
loaded it should be pushed on to the list in ScreenManager. MainMenuScreen will remain in the list until 
the game is exited. 

6.1.2 SelectionScreen 
The SelectionScreen class will implement the Selection Menu Screen discussed in section 2.2.2 of the 
Functional Specification (MacWilliam 2008).  It will have to draw each of the gamer‐selectable menu 
items, which can be highlighted using the up or down arrow keys.  The SelectionScreen class will also 
need to be able to process which menu option the gamer has selected.  If the New Game option is 
selected a new game will need to be loaded.  This means fading the screen (see section 6.1.7) and 
loading the game and HUD screens (see sections 6.1.3 and 6.1.6). If a game is in process the Continue 
option can be selected which will return the gamer back into the game at the same position they paused 
the game by popping the SelectionScreen off the ScreenManager stack.  Selecting the options screen 
will push the OptionsScreen onto the ScreenManager stack which will draw the OptionsScreen. Selecting 
the Exit option will push an end game notifier to the event queue, which will then properly dispose of all 
objects correctly and shut the game down. 

6.1.3 HUDScreen 
This class will handle drawing the heads up display that will be visible to the gamer at all times.  The 
HUD will show the gamer the number of lives remaining, the level they are on, the points they have 
achieved and the time remaining.  These values will be retrieved from the GamerManager class and will 
be updated every time GameManager’s updated method is called and the screen is redrawn.  It is not 
interactive, thus the only event that needs to be handled is the end game event. In this case the HUD 
screen will be popped from the list in ScreenManager so it is no longer displayed.  
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6.1.4 ConsoleScreen 
This class will handle drawing the drop down console screen defined in the Console class that can be 
used to interface with Lua (see section 3.1.4).  The instance of the Console class will be accessed by the 
ConsoleScreen through the Singleton design pattern.  The Console class’ draw method will draw a 
background box for viewing commands over top of the GameScreen and HUDScreen, and a separate 
background box for entering commands. The gamer can type Lua commands and when they press enter 
the input will be processed by Lua and the command along with any output will be drawn to the 
background box for entering commands.  When the Console is deactivated the ConsoleScreen will be 
popped out of the list in ScreenManager, so it will no longer be drawn. 

6.1.5 EndOfGameScreen 
This class will handle the drawing of a simple screen on top of the GameScreen that will help to notify 
the gamer they have lost.  A message telling the gamer they have lost is appropriate.  When the game is 
exited or the gamer wants to return to the SelectionScreen this screen is popped and an EndGame event 
is pushed onto the InputEvent queue. 

6.1.6 OptionsScreen 
This class will handle the drawing of the Options screen discussed in section 2.2.3 of the Functional 
Specification (MacWilliam 2008). It will have to draw each of the gamer‐selectable option menu items, 
which can be highlighted using the up or down arrow keys.  The OptionsScreen class will also need to be 
able to process which option the gamer has pressed the left or right arrows because these will be used 
to change the values of the currently selected option.   

For the resolution option there will be a list of accepted game resolutions that the gamer can select 
from.  When pressing the left arrow the next resolution needs to be retrieved and displayed. If the 
gamer presses the left arrow the previous resolution needs to be retrieved and displayed.  Each time the 
resolution is changed the resolution is written to the preferences file defined in the Preferences class. 

The gamer can select between fullscreen on and off.  Like resolution, each time the option is changed it 
is written to the preferences file.   

The background music can also be toggled on or off.  Each change will be written to the preferences file. 

The music volume can also be set.  Pressing the left arrow key will decrease the volume by 1, and 
pressing the right value will increase it by 1.  100 is the maximum volume level and 0 is the minimum. 

Sound effects can also be toggled on or off.  Each change will be written to the preferences file. 

The sound effects volume can also be set.  Pressing the left arrow key will decrease the volume by 1, and 
pressing the right value will increase it by 1.  100 is the maximum volume level and 0 is the minimum. 
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Selecting the Back option will save all the preferences and pop the OptionsScreen off the list in 
ScreenManager, thus revealing the SelectionScreen again. 

6.1.7 FadeScreen 
This class will handle the drawing of a screen that will fade in and out for a developer programmed 
period of time (most likely 1‐2 seconds).  The FadeScreen will be pushed on top of all screens in the 
ScreenManager list when a new level is loaded.  The fade colour should be set as white.  Alpha blending 
will be used for both fading in and out, thus GL_SRC_ALPHA and GL_ONE_MINUS_SRC_ALPHA should be 
used for the glBlendFunc. When fading in the Alpha value should be set to 0 and should increase linearly 
in steps of 

 

where A is the new alpha value. When the fade is complete the Alpha value needs to be set to 1, just in 
case the fraction is not exactly equal to 1. 

For fading out, which will occur once the new level has loaded the alpha should start at 1 and the alpha 
fade out value should be 

 

6.2 Main Play Screen 

The main play screen is the most complicated of all the screens previously discussed.  Whenever the 
main play screen is loaded (through a call to its load function) the cameras, models, lights and 
controllers all need to be initialized (see section 7.1).  Each of these components will have their own 
initialization functions to make the code easier to understand and use. Once all the components have 
been initialized the Dude model can be activated and all mouse events will be cleared. This is done so 
the camera (which is controlled by the mouse) can always start by facing the same direction every time 
the game screen is loaded.  

Drawing the main play screen is complicated because each component needs to be drawn in the correct 
order.  First the background skybox is drawn, followed by the terrain skybox.  The lighting effects are 
then implemented by calling the draw function of the LightManager class.  Once the lighting has been 
set all objects (Dude, coins, walls, etc.) are drawn by calling the draw function of the DrawManager 
class. Finally the cameras and particle effects are drawn.   

Every time the main play screen’s update method is called the background is updated, any events that 
occurred are updated and recorded, and finally all objects (Dude, coins, walls, etc.) are updated.  Once 
all the correct update methods are called the main play screen is redrawn to reflect the updates. 
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7 Art and Video 

This section discusses the details of the graphics engine and the creation of any animations.  The 
graphics engine will discuss the implementation of cameras, textures, models lighting and fonts that will 
be needed to give Dude*X it distinct look. 

7.1 Graphics Engine 

The graphics engine of Dude*X is responsible for translating the effects of the rest of the game engine 
into  images which are rendered to the screen.   This consists of a number of parts  including Cameras, 
Models, and Lighting, among other smaller components. 

7.1.1 Cameras 
The basic purpose of  the camera object  is  to provide a view point and orientation through which  the 
screen  is  rendered.    The  camera  can  represent  a  variety  of  things.    A  free  camera  can  provide  an 
overview  of  the map/game.    A  fixed  camera  representing  an  actual  camera  object  in‐game  through 
which the character can view some other part of the world.   A controllable camera can represent the 
characters  view,  either  in  first  person or  third  person  depending  on  the method  used  to  control  the 
camera.   

As  the  game  will  require  a  number  of  these  different  camera  types  a  camera  system  needs  to  be 
developed to allow multiple cameras to exist at any given time.  From this point, any given camera can 
be  activated,  at  which  point  the  scene  being  rendered  will  appear  from  the  viewpoint  of  the  active 
camera.  The camera objects should be controllable in the same manner as other game objects to allow 
ease of control. 

7.1.2 Textures 
Textures are often a very resources intensive part of a game and as such, there needs to be a method to 
manage textures within the game.  A texture manager should keep track of all textures that are loaded 
and ensure that any given texture is only loaded once.  Additionally, the texture manager is responsible 
for generating mipmaps for the loaded textures to improve game performance.   

7.1.3 Models 
A model represents the abstract concept of any object that can be draw within the game.  To simplify 
management  of  objects,  all  drawable  objects  should  inherit  from  the  same  base  class,  IDrawable.  
IDrawable provides a method draw() which is overridden to provide the actual drawing functionality of 
the model.  This functionality will vary depending on the model.   

Simple models such as the Skybox will draw a number of quads textured with the skybox.  This involves 
specifying the textures that will be used for each side of the skybox, and drawing a single textured quad 
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for each section of  the box.   The skybox object  is always positioned  in  the  same place as  the current 
camera to produce the illusion of a distant background. 

More complex models such as the game walls are not constantly the same shape and thus are not well 
suited  for  generating  as  3DS models.   Walls must  also  be  affected by  game  lighting  so  they must  be 
made up of larger numbers of quads.  This is done by subdividing the wall into an arbitrary number of 
chucks and drawing a quad for each.  The quads are textured so as to seamlessly repeat the texture.  The 
display lists for the walls should be generated a single time to maximize performance.   

Finally, more complex  in game models (3DS models) are  loaded into the game using a 3DS file parser.  
This includes a number of steps.  First, the meshes are loaded into an object.  As 3DS files do not contain 
normal vectors for vertices, these are now generated.   Second, all animations are loaded from the file 
and converted into the internal format.  Finally a display list is generated for each mesh.  Each mesh has 
an  individual  display  list  to  allow  run‐time modification  (animation)  of  individual meshes  in  a model.  
During this step, any materials or textures required are created or loaded. 

During the drawing step for any model, any specific transforms are applied which positions the model in 
the scene with respect to the camera.   Second,  the drawing code  is executed.   This usually  includes a 
display list but can include other OpenGL calls to manually create objects.  For a 3DS model this involves 
transforming each individual mesh before drawing it.   

7.1.4 Lighting  
Lighting is an important part of any 3D game as it provides a way to make objects appear much more 3D 
and  realistic.    There must  be  an  easy way  to  interact with  the  lighting  system  to  allow  creating  new 
lights, and enabling and disabling lights.  Similar to most other components, lights must be controllable 
to allow them to be animated, positioned, and controlled easily.   

7.1.5 Fonts 
Text is the standard way to provide feedback to the gamer whether it is in the form of a menu system or 
an  in‐game  heads  up  display.    The  graphics  engine  should  provide  a  way  to  load  a  number  of  pre‐
generated font textures into the game and then use them to print various strings to the screen.  Similar 
to  the  texture  manager,  fonts  should  only  be  loaded  a  single  time  and  re‐used  by  the  various 
components of the game. 

7.2 Artist Instructions 

A 3Ds models will need to be created of the Dude.  The Dude should be simplistic and gender‐neutral.  It 
must be simplistic such that any animations will be created (i.e. walking/running) will not be difficult to 
parse and implement in the game. Any elevators, buttons and switches should also be completed in 3Ds 
to give them the detail and accurate animation.   
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Textures will need to be created for the walls, floor, balls, coins and boxes. Any textures created for the 
game must have dimensions equal to 2n.  All textures should be accurately cropped in production such 
that alpha blending will not need to be utilized except in necessary conditions. 

8 Sound and Music 

This section outlines the implementation of sound in Dude*X.  It begins with a brief discussion of the 
various requirements for recording background music and sound effects in order for them to play 
properly in the game, and concludes with a brief overview of how the code will need to be developed in 
order for the correct sounds and music to play at the appropriate times. 

8.1 Sound Engineering 

Background music can be encoded in any currently accepted music format.  However, in order to keep 
the size of the background music minimal it should be recorded in MP3 or AAC format at around 128‐
192kbps. Background music can be longer, but should be able to loop without the gamer noticing.  
Looping is inevitable if the gamers spends their entire time on the same floor; unlikely, but still possible.   

Any sound effects need to be recorded in WAV format and must be dual channel.  The frequency should 
be set at 22050 kHz and should be encoded using 16 bit waveforms.  Sound effects should be no longer 
than 5 seconds. 

8.2 Level Specific Code 

All code will be handled by a Sound Manager that will be created by the game developers.  The functions 
of the Sound Manager will include those that can load, play and pause both background music and 
sound effects.  These functions should be accessible through the Lua scripting interface, such that all 
sound effects can be loaded through a single file at the start of the game through the Lua initializing 
function (see section3.1.4).  Code that calls the correct sound effect ID to play for a specific event (i.e. 
coin is collected) will need to be implemented by the game developers at the correct spot in code (i.e. 
collision with coin is detected). 

The background music will also be loaded at the start of the game, but because it is level specific it will 
be handled in each level’s Lua file.  These level files will be read in the Lua initializing function (see 
section 2.3) and the background music will be loaded at the same time.  Code will need to be developed 
such that when a new floor is loaded the correct background music plays as the floor appears (i.e. in the 
Level Manager).  The background music will help to differentiate the various floors.  
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HELP

- Modify the GREEN cells and the WBS, Tasks, and Task Lead columns. The rest of the columns are formulas.
- The number of weeks shown in the gantt chart is limited by the maximum number of columns available in Excel.
- The Start Date that you choose determines the first week in the gantt chart, starting on a Monday.
- Use the slider to adjust the range of dates shown in the gantt chart.
- Only 48 weeks can be shown/printed at one time, because each week uses up 5 columns.

Q: The Working Days column shows "###". How do I fix that?
You need to install the Analysis ToolPak add-in that comes with Excel. Go to Tools > Add-ins, and select Analysis ToolPak.

Q: How do I make Task 2 start the day after the end of Task 1?
Use the following formula for the start date of Task 2:
=EndDate+1
where EndDate is the reference to the cell containing the end date of task 1

Q: How do I add/insert tasks and subtasks?
Copy the entire ROW (or a group of rows) for the type of task(s) you want to add and then right-click on the row where you want to insert the new tasks, then select 
Important Note: When inserting a new subtask after the last subtask or before the first subtask, you will need to update the formulas for calcu
(see below) to include the new subtask, because the ranges won't automatically expand to include the additional row. 

Q: How do I calculate the %Complete for a Level 1 task based upon the %Complete of all of the associated subtasks?
Example: If Task 1 is on row 11 and the subtasks are on rows 12-15, use the following formula:
=SUM(F12:F15)/COUNT(F12:F15)

Q: How do I calculate the Duration for a Level 1 task based upon the largest end date of a sub task?
Example: If the Level 1 task is on row 11 and the sub tasks are on rows 12-15, use the following formula
=MAX(D12:D15)-C11

Q: How can I include holidays in the calculation of the Working Days?
You can add a list of holidays to exclude in the NETWORKDAYS function. See Excel's help (F1) for more information.

Q: How do I change the print settings?
Select the entire range of cells that you want to print and then go to File > Print Area > Set Print Area. Then go to File > Page Setup or File > Print Preview and adjust the Scaling and Page 
Orientation as desired.
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